Network ldentity Manager 1.3.1 User Documentation
MIT Kerberos for Windows Release 3.2.2
Copyright 2004-2007 by the Massachusetts Institute of Technology
Copyright 2006-2007 by Secure Endpoints Inc.

WHAT IS NETWORK IDENTITY MANAGER?......coi ittt sttt st st sre s 3
HOW TO START NETWORK IDENTITY MANAGER .........cocoiiiiii ittt 4
OBTAINING CREDENTIALS .....oooiii ittt ettt ettt sttt sbe e ebe et e et e s abesbaesbaesbeesbeseesnneans 4
NETWORK IDENTITY MANAGER APPLICATION WINDOW........ccocoiviiieiii et 5
NETWORK IDENTITY MANAGER COMMAND LINE OPTIONS........ccocoot ittt 9
NETWORK IDENTITY MANAGER COMMAND REFERENCE.........cccccocviiiiiiieice e 10
=SSP 10
(0] 0T TSP 10

EXIE COMMANG ..ottt ettt be et b e et e et e et b e st e e s be e sbe e besabesaeesbeeebeeabeenbeeabestaesbaesbes 11
(@] T N o PSSO 12
New Credentials Command, CEIIHN .......ooiiiiiiiiiiicce et be e b sbae b s 12
Renew Credentials Command, CLIIFR ........ooiiiiiiiiice e st 15
Import Credentials Command, CIrIH1........cccoiviiiiiicece e 16
Destroy Credentials Command, DEl..........cccoiiiiiiiiieieiene et re e e 16
Change Password COMMANG..........curiiiiriiiniseeee bbbttt e 16
VLB ettt ettt ettt ettt e e et e e e e bb e e e e et b e e e e eateeeeeheeeeeehbeeeeaabreeeaheeeeaatbeeeaaateteeabreaeaatbeeeaareeeeabaeeeaatbeeeaanes 18
AAVaNCed COMMANT, F7....cviiiiiiiie ettt et be e st e e s be e sabe s sabeesabe s sareenanas 18
2011 ST PP TR TR PP OPPTUPTUPTPPTIO 18
LaYOUL BY THENTIY....ueiieiciccic et e et e st st e s teesees e e e e besbesbesteeneeneeneens 19

[ (Yo L1 =V Y o L= PSPPSR UPRPP 20
=\ =V 0T 4 o ) o RS TPPSRSRS 21
L1 ] (0] PSSR 21

AL TOENEITIES 1ottt et st e be e be e ebe et e e st e et b e sbeesbaesbeesbeesbesneesaseabeeebeebeenreens 21
VIBW COUMINS ..ottt ettt ettt st s b e e be e ebeeebeeabeeab e et b e steesbaesbeesbeesbesneesaseabeeabeenbesnreans 22
RefresSh COMMAN, F5.....viiiiiiccei ettt ettt e et e s st e e ebe e e sbaeesbee e sbeeeabeeesbeeenbeeeses 22
(O] 10 NSRS URRROR 23
LC1S g TC = I O o] 1 [o] 4O URURUSRP 23
APPEATANCE OPLIONS ...ttt ettt bttt b et b e bt st e s e e seeeb e sk e eb e e b e et emeeseeabesbesbesbeaneaneennn 24

[0 LT gL e O] o] (o] 4 USSP 24

N0 )0z LT TR O o o] S TPSPSRSRS 32
PIUG-INS AN MOGUIES........couieieiciie ettt e et e s be st e s beebeere e e et e sbesbestennaeneas 33
Kerberos V5 CONfIGUIALION ........c.iiiiieie ettt s b e teere e s e e et e aesbestaeneeneeneens 34
Kerberos V4 CONfIQUIALION ........ccviiiiee ettt seesa e e et e aesresreeneeneeneens 36

FAN I o] 1) T 11 L= 14 o] o SR 36

o [ SR SUSSR 37
About Network 1dentity MANAGET ........coooiiiieieee e et 37
WINDOWS TASKBAR NOTIFICATION AREA ..ottt ettt bt sae s 38
WINDOWS TASKBAR NOTIFICATION ICON IMENU .....ccciiiiiiiiiiie ittt eetee et e ettt eeatee e snbaee e s etveeeenes 38
Show Network Identity Manager window / Hide Network Identity Manager window..............ccccccee.... 38
ODbtaiN NEW CTEABNTIAIS ... ..iiiveiiiii ettt e et e s beesbe e s ebeeeabeesbeesabeeabaesnreeas 38



Network ldentity Manager 1.3.1 User Documentation
Kerberos for Windows Release 3.2.2

LR 11T AR 39
IMPOIT CrEABNTIAIS. ......eiteecttiee et bbbttt bbbt 39

D= ()T TP P P U PP RTTRTUPPTUPTOPTPPTIO 39

T A B L) 1= 10| L TR 40
CNANGE PASSWOEU ...ttt bbbttt bbb bt et e heemb e b e b e s besbe et e atere e e ennas 40
HEIP CONENES ...ttt et e st e teeRe e s et et e besbesteeneesbesnebeseesbestaaneeneeneens 40
About Network 1dentity MANAGET ..........cceii ittt st e et e et re b e resreere e e enee s 40

L TR 40

IO 1O ] I =7 N = TR 40
(G101 oA = L] = I TSRO 42
NETWORK IDENTITY MANAGER COPYRIGHT ...uvvtiiitiieeiitieeeeeitieesstseeesetteessssaessssnaessssssessssssessssssenesssssesesas 42
IKERBEROS COPYRIGHT ...tuttiiiieeiiiiittttiseessesiatbettsasssesasbbasasasesssasbbasasasesssasbbabesesesssassbebaessesssasbbbbenssesssassrrres 42
KERBEROS EXPORT RESTRICTIONS AND SOURCE CODE ACCESS.....cciiiiiiiitiiiiieieesiiiitrieesessssssssesssessssssnnnns 43
REPORTING BUGS AND REQUESTING ASSISTANCE ........coooii et sne e 43
OBTAINING KERBEROS FOR WINDOWS SOURCE CODE AND SDK ......ccoocieiivieeicee e 43
IMPORTANT NOTICE REGARDING KERBEROS V4 SUPPORT ....ccvviiiieee et 44
REFERENCES ...iiitttttttie et ieiitteet e e e s seiabbeeteeessesabbaaeeeeeessa b baseeeeeessaabbaa e e e e e e s sabbebeeeseessaab b b baeeseessasbbbbaneseessasantres 44

Page 2



Network ldentity Manager 1.3.1 User Documentation
Kerberos for Windows Release 3.2.2

What Is Network ldentity Manager?

Network Identity Manager (NetldMgr) is a graphical tool designed to simplify
the management of network identities and their credentials which are used by
- network authentication protocols while providing secure access to network
services. When NetIDMgr is used with Kerberos v5, each Kerberos v5 principal
name is a network identity and the credentials are Kerberos v5 tickets. Kerberos
v5 tickets can be used by NetIDMgr to obtain Andrew File System (AFS)
tokens”, and X.509 public key certificates™.

g

When you log into Microsoft Windows with a domain account, your account
name and the Windows Domain name when combined form a Kerberos principal name. As an example,
“WINDOWS\user” is actually a short form representation of user@WINDOWS.DOMAIN. Microsoft
Windows uses Kerberos-based network identities for all domain-based network authentications.

Since Microsoft Windows already provides a network identity, why do you need NetldMgr? Here are
some examples:

1. Your only network identity is your Windows Domain account but you have third-party
applications that rely on MIT Kerberos for authentication for access to remote files, e-mail, web
data, or other services. In this scenario, NetldMgr will automatically import your Windows
Domain credentials into a form that can be used by applications that rely on MIT Kerberos.

2. You do not have a Windows Domain account but you must obtain network credentials in order to
securely access a network service. In this scenario, NetldMgr can be used to obtain new
credentials for network identities and can automatically renew them before they expire.

3. You have Kerberos credentials for a network identity and you have third-party applications that
require an alternative form of network credential, such as an AFS token or a X.509 certificate,
which can be obtained via a Kerberos authentication. In this scenario, NetldMgr can
automatically use your existing credentials to obtain and renew the additional network credentials
types.

4. You have a Windows Domain account but you need to authenticate to a service belonging to a
Kerberos realm outside the Windows Domain. In this scenario, NetldMgr can be used to manage
multiple network identities, the Windows Domain identity as well as the additional Kerberos
identity required for the external network services.

5. You have multiple network identities within the same Kerberos realm which are used for different
roles. For example, an unprivileged user identity and a privileged identity that is only meant to be
used for system administration. In this scenario, NetldMgr can be used to obtain credentials for
all of your identities and automatically renew them as necessary.

NetldMgr’s automated credential acquisition and renewal makes it an invaluable tool necessary when
providing users with a Single Sign-on experience.

NetldMgr is most commonly configured as a StartUp item and remains running with an icon in the Taskbar
Notification Area until you logout. While running, NetiIDMgr automatically renews your credentials,
notifies you of pending expirations and prompts you when a Kerberized application requires credentials
that have not already been obtained.

When configured to do so, NetldMgr will prompt you immediately after it starts to obtain Kerberos
credentials. This is often referred to as logging on to Kerberos. NetldMgr does not perform a logon in the
sense of the Windows Logon Service. A logon service would do more than manage Kerberos tickets. A
logon service would authenticate you to the local machine, validate access to your local file system and

“ A OpenAFS plug-in is distributed with OpenAFS for Windows release 1.5.9 and above.
* A Kerberized X.509 Certificate Authority plug-in is available from http://www.secure-endpoints.com
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performs additional set-up tasks. These are beyond the scope of NetldMgr. NetldMgr simply allows you to
manage Kerberos identities on behalf of compatible applications and to change your Kerberos password.

How to Start Network ldentity Manager

There are many ways to start Network Identity Manager.. In addition to clicking on a Network Identity
Manager shortcut, you can start NetldMgr from the Windows command Prompt or Start Menu Run...
option. NetldMgr supports a number of command-line options which may be specified.
e If you run NetldMgr with the options -i or --kinit, it will display the obtain new credentials dialog
and exit;
e -mor --ms2mit or --import will import tickets from the current Microsoft Windows logon session
(if available) and exit;
e -d or --destroy will destroy all existing tickets and exit; -r or --renew will renew existing Kerberos
tickets (if possible) and exit;
e -aor--autoinit will display the ticket initialization dialog if you have no Kerberos tickets.

Other command-line options:
e -xor --exit will signal a previously started instance of NetldMgr to exit.
e --hide and --show can be used to close or open an existing NetldMgr application window.
e --minimized can be combined with other commands to start the NetldMgr application in
minimized mode.

You may create a shortcut to NetldMgr within your Windows Startup folder (Start Menu->Programs-
>Startup) if one has not been created for you by the MIT Kerberos for Windows installation package. A
shortcut to “NetldMgr.exe --autoinit” ensures that Kerberos tickets are available for the use of Kerberized
applications throughout your Windows logon session.

Obtaining Credentials

When Network Identity Manager starts, if it is configured to obtain new credentials at startup (if none
are present) and no credentials are present, the Obtain New Credentials dialog will be displayed.

is. Obtain new credentials
Username || -
Realm | j
Cancel | =x ‘

This dialog prompts you for the Username and Realm. The Username field can be used to enter the entire
Kerberos principal name.

) jaltman@ATHENA.MIT.EDU - New credentials
Username |ja|h‘nan@ATHEF—lA.I’v11T.EDU ﬂ
Realm | J

Password for jaltman@ATHENA.MIT.EDU | |

‘ ok | Cancel | =x ‘

If the entered name can be verified, you will be prompted to enter your password. If the entered name
cannot be validated, you will be presented an error message.
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&) Obtain new credentials @
Username | invalid-user| j
Realm | NOT-A-REALM |

Validity of identity invalid-user @NOT-A-REALM couldn't be determined.
' "_\
L

Cancel ‘ =

If the password is successfully entered, your credentials will be obtained. If not, you will be presented with
a balloon in the notification area of the Windows Task Bar. Clicking on the balloon will provide you
additional information regarding the error condition. For example:

i/ Failed to get credentials for jaltman@ATHENA.MIT.....

@ Decrypt integrity check failed

Hl-r; This is commonly caused by an incomect password. Flease verify
that the password is comect and note that passwords are case
sensitive.

For additional information on the Obtain New Credentials dialog, see the section on the Credential->New
Credentials ... menu item later in this document.

Network Identity Manager Application Window

The Network Identity Manager application , -

window when open displays the current status | Network Identity Manager (=[x
of your network identities and provides you File Credential View Options Help

the tools necessary to obtain new credentials, = = = = ~

renew existing credentials, destroy Lj ﬁ S S EARI L=
credentials, change your password, configure Identity |

the behavior of your network identities, and
access the on-line help. There are two
primary views of network identity status:
basic and advanced.

jaltman@ATHENA.MIT.ECU (Default)

Expires in 20 hours 57 minutes

jaltman@CC.COLUMBIA.EDU

Expires in 9 minutes

jaltman@FNAL GOV

Expires in 3 minutes 6§ seconds

m jaltman@WINDOWS.SECURE-ENDPOINTS.COM
(Expired)

I:l jaltman@IPL.NASLA.GOV

K ¥ K

In the basic view, the window title contains
the name “Network Identity Manager”.
Below the title are a menu bar; a tool bar; and
a list view. The background of application
window contains a watermark, the Network
Identity Manager logo.

I:l jaltman@SECURE-ENDPOINTS.COM

e e Y I SV o

jea@stanford.ed
The NetldMgr basic view displays a list of [ feTEeEmere ety

network identity names (aka Kerberos
principals, user@REALM). Each entry

appears with a push-pin @ or 19 putton and ‘ |

an ldentity icon [M to its left. Below the
identity name is the remaining lifetime of the
identity’s credentials.

The Network Identity Manager manages
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multiple identities. Most applications do not know how to request a specific identity or how to search for
the appropriate credentials cache. Instead these applications assume that the identity to be used is stored
within the default credentials cache. NetldMgr allows one identity to be specified as the default identity.

The push pin buttons are used to choose whether an identity should be displayed even when there are no

credentials. %2 indicates that the identity will be displayed when there are no credentials. A indicates
that the identity will not be displayed unless there are credentials. The push pin button act as a toggle
between the two states.

In the above image, there are many identities listed. jaltman@ATHENA.MIT.EDU is the default identity
and it has valid credentials (green) that will expire in 21 hours and 10 minutes. The
jaltman@CC.COLUMBIA.EDU and jaltman@FNAL.GOV identities also have valid credentials which are
about to expire (yellow and orange). The jaltman@WINDOWS.SECURE-ENDPOINTS.COM identity has
expired credentials (red). The other identities have no credentials but are listed because they are pinned.
The jaltman@SECURE-ENDPOINTS.COM identity is selected with the cursor (grey). Other configured
identities exist but they neither have credentials nor are they pinned.
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In the advanced view, the window title contains the name “Network Identity Manager”. Below the title are
a menu bar; a tool bar; and a tree view. The background of application window contains a watermark, the

Network ldentity Manager logo.

&} Network Identity Manager

mExX

File Credential View Options Help

Dbz eE® @

wd| Identity | Type | Service Name

| Time Remaining | Renewable Time left | Kerberos v5 Flags |

53 [y jall @ATHENA.MIT.EDU (Default)

J Kerberos v5 credentials

(% krbtgt/ ATHENA.MIT.EDURATHE... 20 hours 50 minutes & days 23 hours FRI
ES afs/athena.mit.edu@ATHENA.M... 20 hours 50 minutes & days 23 hours FR
£ afs/dev.mit.edu@ATHENA.MIT.... 20 hours 50 minutes 6 days 23 hours FR
) afs/iastate.edu@IASTATE.EDU 20 hours 50 minutes 6 days 23 hours FR
S afs/net.mit.edu@ATHEMNA.MIT.E... 20 hours 50 minutes & days 23 hours FR
(%] afs/raesburn.crg@RAEEURN.ORG 9 hours 36 minutes 6 days 23 hours FR
(%) afs/soap.mit.edu@ATHENA.MIT... 20 hours 50 minutes & days 23 hours FR
B afs@ANDREW.CMU.EDU 20 hours 50 minutes 6 days 23 hours FR.
(% afs@CMF.NRLNAWVY.MIL 9 hours 36 minutes 0 seconds FR
£.8 afs@CS.CMU.EDU 20 hours 50 minutes 6 days 23 hours FR
£ afs@DEMENTIA.QRG 20 hours 50 minutes 6 days 23 hours FR
) kea_service/clucky.andrew.cm... 20 hours 50 minutes 6 days 23 hours FR
(%] krbtgt/ ANDREW.CMU.EDU@AT... 20 hours 50 minutes & days 23 hours FR
£ krbtgt/CMF.NRL.NAVY.MIL@AT... 20 hours 50 minutes & days 23 hours FR
(= lerbtgt/CS.CMU.EDU@ATHENA.... 20 hours 50 minutes 6 days 23 hours FR
E.S krbtgt/DEMENTIA.ORG@ATHEN... 20 hours 50 minutes 6 days 23 hours FR
(%] krbtgt/IASTATE.EDU@ATHENA.... 20 hours 50 minutes 6 days 23 hours FR
£ krbtgt/RAEBURN.ORG@ATHENA... 20 hours 50 minutes 6 days 23 hours FR
B 4FS credentials
| afs@andrew.cmu.edu 20 hours 50 minutes
| afs@athena.mit.edu 20 hours 50 minutes
| afs@cmf.nrl.navy.mil 9 hours 36 minutes
| afs@cs.cmu.edu 20 hours 50 minutes
| afs@dementia.crg 20 hours 50 minutes
| afs@dev.mit.edu 20 hours 50 minutes
| afs@iastate.edu 20 hours 50 minutes
1 afs@net.mit.edu 20 hours 50 minutes
1 afs@raeburn.crg 9 hours 36 minutes
| afs@soap.mit.edu 20 hours 50 minutes
O kca certificate
| CMU CA ISAM user identity 20 hours 50 minutes
28 9 W jaltman@CC.COLUMBIA.EDU
Kerberos v5 credentials
(] krbtgtu"CC‘COLUME_IA‘EDL_I@CC‘.. 2 minutes 54 s_eccnds FI
© B e AL GO
El kerberos vS credentials
@, lerbtgt/FNAL. GOVE@FNAL. GOV (Expired) & days 23 hours FIA
) afs@FNAL.GOV (Expired) FA
Q kca_service/modoc.fnal.gov@F... (Expired) A
B 4F3 credentials ’
Q, afs@fnal.gov (Expired) |
B kca certificate
Q Kerberized CA (Expired)

In its default configuration, the NetldMgr advanced view displays a list of network identity names (aka

Kerberos principals, user@REALM). Each entry appears with a = or = button, a @ or 42 button and
an ldentity icon [M to its left. Click on the & button of an identity to expand the branch, displaying a =
button. Click on the = button to hide the branch.

Below each network identity, the tree lists credential categories. Below each credential category are the
active credential locations and the current credentials belonging to the category. Each credential entry
contains the current credential status, the service name and time remaining before expiration.

The tree updates once per minute. If you need an immediate update of your ticket status, you can press the
Update Display button on the toolbar or the F5 key.

To the right of each credential is a flag icon representing one of the following states:
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None = credentials are valid

&S = credentials are valid and renewable

.4 = credentials are valid and the initial expiration warning has been issued
E3 = credentials are valid and the final expiration warning has been issued
) = credentials are invalid or expired

Attempts to renew renewable credentials are performed at half-life intervals and 15 minutes” before
expiration.

A Network Identity Manager E]@

File Credential View Options Help

OR-OH- @z& @

= e EITT . .- R = - el
_7?] 1gentity ] Tyvpe ‘ Location | Sendce Njme Time Remaining )
@ W plman@ATHENA MITEDU (Default)
L2 & [ jkman@SECURE-ENDPOINTS.COM
B Ketbers

B APLjakman@SECURE- ENDPOINTS.COM

] krbtgt/SECURE-ENDPOINTS.COM@SECURE-ENDPCINTS.... 8 minutes
pe=

Fiy T e e e
3=/ secure-engpoints.com@SECURE- ENDPOINTS.COM € minutss l

) @

£ minctes [

||

At 10 minutes and 5 minutes* before your credentials expire, a balloon tip is displayed to warn that your
credentials will soon expire and to provide you the opportunity to obtain new ones.

A Network Identity Manager E]@

File Credential ‘iew Options Help

OR-OH @& @

= e . .- R = — [oge]
_7?] 1gentity ] Type ‘ Location | Service Name Time Remaining ||
2 [ Elman@ATHENA MIT.EDU (Default)

50 2 [W pkman@SECURE-ENDPOINTS.COM
FinrE

B Hetbarosy

=E f W SECUWRE-ENDPOINTS.COM
.9 krbtat/SECURE-ENDPCINTS.COM@SECUVRE-ENDPCINTS.... 4 minutes 34 ...
ES 3R secube-end . com@SECUVRE-ENDPOINTL.LOM 4 minutes 34 sac.. L=
B AFS credentials
B ars Cache v 13n3ger |
£3 Er’s@;&:u!'&—s:‘:c‘_p:ih-‘l;.:srr‘ 4 minutes 34 sec !V!

Credentials that can not be renewed will expire.

“ The actual time is configurable. 15 minutes is the default time. Automatic renewal may be disabled by
using the Notifications Options page.

* The actual times are configurable. 10 minutes and 5 minutes are the default times, Expiration warnings
may be disabled by using the Notifications Options page.
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&b Network Identity Manager g@
File Credential View Options Help
DR-OA- E& 6
Identity )
jaltman@ATHENA MIT.EDV
o [ =
jalman@SECURE-ENDPOINTS.COM
[
At man@WINDOWS SECURE-ENDPOINTS.COM
@ o 1
ik Network Identity Manager E]@
File Credential View Options Help
OBH-OAH- =& @
T sdentity | Tpe | Lection | Service Name Tims Remaining =
@ [W plman@ATHENA MITEDU (Default)
© 0 3 [ iltman@SECURE-ENDPOINTS.COM
B Kerberss 5 credentizls

B APLjakman@SECURE- ENDPOINTS.COM

@, krbtat/SECUVRE-ENDPOINTS.COM@&SECUVRE-ENDPPOINTS....  (Expired)
) 3fs/secure-endpoints.com@SECURE- ENDPOINTS.COM (Expired)
= AFS :I'a:.'je!':t52!'
= AFS Cache Mana ger l
Q 3:”3@5&:;4!'&—5:‘::‘_‘;:5.“'-".;.::? (Expired) 'v

Andrew File System (AFS) token management is available only on machines that have installed OpenAFS
for Windows”. KCA certificates management is available only on machines that have installed the Secure
Endpoints Inc. KCA plug-in®.

Network Identity Manager Command Line Options

When NetldMgr is executed from the command line one of the following command line options may be
specified:

--kinit, -i performs a Kerberos ticket initialization (and exits)

--ms2mit, --import, -m imports credentials from the Windows Logon Session (and exits)

--renew, -r renews credentials (and exits)

--destroy, -d destroys credentials (and exits)

--autoinit, -a performs ticket initialization only if the credential cache is empty

--exit, -x closes any copy of netidmgr currently running in the same Windows Logon Session

--hide and --show can be used to close or open an existing NetldMgr application window.

--minimized can be combined with other commands to start the NetldMgr application in minimized mode.

# OpenAFS for Windows 1.5.9 or higher is required. http://www.openafs.org
“ The Kerberized Certificate Authority plug-in can be downloaded from http://www.secure-endpoints.com/.
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Network Identity Manager Command Reference

File:
File Credential View Options Help

Properties

Exit Ctrl+x

Properties...
From the File menu, will display the Properties dialog for the currently selected item whether it be an

Identity or a Credential.

-,

jaltman@ATHENA.MIT.EDU Properties 2JE3

Identity |

Marne Iialh'nan@.ﬁ.THEN.ﬁ..MlT.EDLl
Default identit Always visible (sticky)

Property Value

Expires on 12/3/2005 4:43:55 PM

Flags FRI

Issued on 12/3/2005 3:40:5% PM

kKrb5 CCache API:jaltman@ATHENA.MIT.EDU

Renewable time expires  12/10,/2005 2: 10:59 PM

[ Identity configuration ...

[ Ok l [ Cancel App

An Identity Property dialog
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' kebtgt/ATHENA. MIT.EDU@ATHENA. MIT.EDU Prope... | 2 59|
m| Credential | Identity |

Mame krbtgt/ATHENA.MIT,EDU@ATHENA.MIT,EDU|
Issued on 12/4/2005 6:34:21 PM
Valid il 12/4/2005 7:37:15 FM
Renewable til 12/11/2005 6:34:21 PM
Ticket flags Forwardable

Initial

Renewable

(04 l [ Cancel ] App

A Kerberos v5 Ticket Property dialog

- -1
—
krbtgt/ATHENA.MIT.EDU@ATHENA.MIT.EDU Prope...
Kerberos 5| Credential | Identity |
Property Value
Expires on 12/4/2005 7:37: 15 PM
Flags FRI
Identity jaltman@ATHENA. MIT.EDU
Issued on 12/4/2005 &:34: 21 PM
Key EncType DES-CBC-CRC
Lifetime 1 hour 2 minutes
Location APT:jaltman@ATHEMA, MIT.EDU
Renewahle lifetime 7 days
Rernewable time expires 12112005 6:34:21 PM
Service Name krbtgt/ATHENA.MIT.EDU@ATHEMA. . .,
Ticket EncType DES-CBC-CRC
Type Kerberos 5 tickets
()4 l [ Cancel ] App

Associated credential properties

The properties dialog can also be displayed by pressing the [8 button on the Identity header, by double
clicking a credential, or by clicking on the credential status flag.

Exit Command
From the File menu, you can use this command to exit the Network Identity Manager.
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Important Note...
Exiting the Network Identity Manager will not destroy your current credentials. Unless you have chosen to

delete credentials on exit from the General Configuration page, you need to use the destroy credentials
command.

Credential:
File Credential View Options Help

| Obtain new credentials ... Ctrl+Hd

Renew b Renew all identities

™ Import Credentials Cirl+l

cmp Renew jaltman@ATHENA.MIT.EDU
Destroy L4

Renew jaltman@CC, COLUMBLA.EDU
Renew jaltman@FMAL, GOV

Renew jaltman@WINDOWS, SECURE-ENDPOINTS. COM
|# Change password |

New Credentials Command, Ctrl+N

This command is found under the Credentials menu; it is also the first button \j(from the left) in the
toolbar. Use this command to obtain new credentials.

i) jaltman@SECURE-ENDPOINTS.COM - New credentials
Username |ja|h‘nan ﬂ
Realm | SECURE-ENDPOINTS, COM ~|

Password for jaltman @SECURE-ENDPOINTS.COM

‘ Ok Cancel | s

When you select this command, NetldMgr displays a dialog requesting your Username, Kerberos Realm,
and Password; if these are correct, NetldMgr will obtain tickets using either a known configuration for the
entered identity (Username@Realm) or the default identity configuration if the identity has not been
previously used.

If you wish to alter the configuration for the entered identity, activate the Advanced view by pressing the
“>>" putton.
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i/ jaltman@SECURE-ENDPOINTS.COM - New credentials
Identity lKerberos w5 ] AFS ] Kerberos V4| KCA Certificate ]
Username | jaltman - %
Realm | SECURE-ENDPOINTS, COM ~|
Password for jaltman @SECURE-ENDPOINTS.COM Cancel

Credentials  [Selected identity: jaltman@SECURE-ENDPOINTS.COM
Mot default identity. {make default)

Krb5 : Tickets for realm SECURE-ENDPOINTS.COM

IAFS : Credential for cell secure-endpoints.com

Krbd4 : Disabled {click here to enable)

KCA : Cerfficate for realm SECURE-ENDPOINTS.COM

<<
Help
In the Advanced view, a credentials browser window displayed along with tabs for each credential type that

can be obtained for this identity. The credentials browser summarizes the state of the identity and which
credentials will be obtained as part of a successful authentication.

i/ jaltman@SECURE-ENDPOINTS.COM - New credentials
Identity Kerberosv5 | AFs | Kerberos v4 | KCA Certificate |
kerberos v5 Credential Options Ok
Realm | J
Cancel
Lifetime | 15 minutes

[ Renewable for |
[~ Can be forwarded to other machines
v Addressless

<
Help

Kerberos v5 options include the ability to select the ticket lifetime as well as renew and forwarding. The
Kerberos v5 ticket granting ticket represents the selected identity. As such, obtaining a Kerberos v5 ticket
is mandatory.

When Forwardable tickets are received from the Kerberos Server, these tickets can be forwarded to a
remote host when you connect via telnet, ssh, ftp, rlogin, or similar applications. When tickets are
forwarded, there is no need to obtain Kerberos tickets again to access Kerberized services on the remote
host. Forwardable tickets are often required when authenticating to a remote host using ssh or ftp when
the remote host requires the ability to authenticate to a remote file system such as AFS.

When Renewable tickets are received from the Kerberos Server, the ticket lifetimes may be renewed

without prompting the user for her password. This allows Kerberos tickets to be issued with short lifetimes
allowing compromised accounts to be disabled on short notice without requiring the user to enter a
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password every few hours. When combined with Automatic Ticket Renewal, NetldMgr can maintain
valid tickets for a week, a month, or longer by automatically renewing tickets prior to their expiration. The
ability to renew tickets without a password is limited by the ticket’s renewable lifetime as issued by the

Kerberos Server.

When Addressless is selected, the tickets do not contain IP address information. This enables the tickets to
be used from behind Network Address Translators which are frequently found in Cable and DSL Modems.

) jaltman@SECURE-ENDPOINTS.COM - New credentials

2Je

Identity ] Kerberos w5 ] AFS
kerberos v4 Ticket Options

[v Obtain Kerberos v4 credentials

Cbtain Kerberos v4 credentials using

" Automatically determine method
" Kerberos v5 to v4 translation

" Password

| ke certificate |

Cancel

<
Help

Obtaining Kerberos v4 tickets is optional and may not be available on all systems. When available,
Kerberos v4 tickets may only be obtained for the default identity. Kerberos v4 tickets may be obtained via
use of a Kerberos v5 to 4 translation service or by a separate password based request. Selecting
“Automatically determine method” will first try the translation service and if that fails, the password based
request will be attempted. Automatic renewal of Kerberos v4 tickets can only occur if the translation

service is used.

) jaltman@SECURE-ENDPOINTS.COM - New credentials

AF5 Credential Options

[¥ Obtain AFS credentials
Credential for

Identity I Kerberos wS AFS | Kerberos v4| KICA Certificate ]

Cancel

cell athena.mit.edu

Realm | (Automatic)

Method | {Automatic)

Cell | Realm | Method
L}aﬂ'uena.mit.edu (Auto) (Automatic)
Gsecure-endpnints.cnm (Auto) (Automatic)

et
Help

Obtaining AFS tokens is only available on systems with an appropriate version of OpenAFS for Windows
installed. An identity may be used to obtain tokens for multiple AFS cells. The Add/Update and Delete
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buttons are used to manage the list of AFS cells. If the Kerberos realm associated with the AFS cell
cannot be automatically determined, it may be entered manually. The method of AFS token acquisition is
one of: “Automatic”, “Kerberos v5”, “Kerberos v5 to v4” or “Kerberos v4”. Kerberos v5 based tokens
should be used when possible. If not, the next best choice is the Kerberos v5 to v4 translation service. As
a last resort, a Kerberos v4 ticket request can be used directly. In most cases, using “Automatic” will just
work.

Network Identity Manager Configuration
Options for jaltman@SECURE-ENDPOINTS.COM

jaltman@rILe)
jaltman@Ra General ] Kerberos w5 ] AFS ] Kerberos w4 KCA Certificate l
jaltman@sE

jaltman@TR [+ Obtain a KCA certificate for this identity

jaltman@wi
jea @ATHEN

O

O

O

O

g Realm | KCA Servers |
[ jea@FNAL.C
(o]

(o]

(o]

(5]

(5]

O

|# SECURE-ENDPOINTS.COM (Identity) (Automatic)

jea@stanfor
jea@WIN.5|
needchange:
tequila @AM
trng07@UML
wanilla @5LA Realm |

Lllzzi:zhons KCA servers to use (optional): LT

Kerberos v5 b | | Remove ...

@ Realms

— meede Al

a [

KCA Certificate

o o |

[

Ok | Cancel | |

A Kerberized Certificate Authority certificate is an X.509 certificate that can be used with web browsers to
authenticate the user as the Kerberos identity even though Kerberos authentication is not used
authentication to the web server. The KCA certificate can be obtained from servers in the identity realm or
from servers in an alternate realm. As of the KCA 1.1 plug-in, only one KCA certificate can be obtained
for a given identity. Obtaining KCA certificates is only available on systems with a KCA plug-in installed.

i) jaltman@SECURE-ENDPOINTS.COM - New credentials
Username |ja|h‘nan ﬂ
Realm | SECURE-ENDPOINTS, COM ~|

Password for jaltman @SECURE-ENDPOINTS.COM

=-<=-<=-<=-<=-<=-<=-<=-<HHHHHHHHHHHHHHHHHHHHHHH| |

‘ ok Cancel | =x ‘

After entering the correct password for the selected identity, press the Ok button to obtain the specified
credentials.

Renew Credentials Command, Ctrl+R

This command is found on the Credential menu; it is also the second button E (from the left) in the
toolbar. Use this command to renew credentials either for all identities or the specified identity on the
menu. Individual credentials can be renewed by selecting them in the Advanced View and using the right-
mouse context menu Renew option. If the selected identity cannot be renewed without a password, a
dialog will be displayed providing an opportunity to obtain new credentials.
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Import Credentials Command, Ctrl+|

This command is found on the Credential menu; it is also the third button S (from the left) in the
toolbar. Use this command to import the Windows Logon Session Identity credentials into a MIT Kerberos
credential cache. Importing tickets will not result in the destruction of existing tickets. If the imported
identity is the default identity, the MIT credential cache will be used in preference to the Windows logon
cache for applications written to the MIT Kerberos or GSS programming interfaces.

Note: This command is only available if your Windows Logon Session is authenticated using Kerberos.

Destroy Credentials Command, Del

This command is found on the Credential menu; it is also the fourth button S (from the left) in the
toolbar. Use this command to destroy credentials for all identities or a single identity.

Once credentials are destroyed, you must Obtain or Import new credentials before Kerberized applications
can once again access network services.

Change Password Command

This command is found on the Credential menu; it is also the fifth button E (from the left) in the
toolbar. This dialog allows you to change your Kerberos password. This dialog will be automatically
presented if an expired password is detected while obtaining new credentials.

&) jaltman@SECURE-ENDPOINTS.COM - Changing password
Username |ja|trnan j
Realm | SECURE-EMDPOQIMTS.COM ﬂ

Changing Kerberos w5 Password

Current Password | | |

MNew Password | |

Mew Password again | |

ok | Cancel | =x ‘

Note: This command will not change your local machine password unless you login to your computer using
a Windows Domain account or otherwise authenticate using an MIT Kerberos identity.
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Do choose:

*

*

How To Choose a Password...

Your passwords are the keys to many computers, from a bank machine to a multiuser mainframe to a
server on a network. Your password helps to prove that you are who you say you are, and ensures your
privacy.
Compromised passwords are the means by which most unauthorized (and unscrupulous) people gain
access to a system. Someone logging on under your name has access not only to your computer files,
but to most of the facilities of the computer system. Since tampering can have far-reaching and serious
consequences, it's important to take to heart the following guidelines for choosing a password.

Something easy for you to remember with at least six characters.

Something obscure. For instance, you might deliberately misspell a term or use
an odd character in an otherwise familiar term, such as "phnybon" instead of
"funnybone." Or use a combination of two unrelated words or a combination of
letters and numbers.

A combination of letters and numbers, or a phrase like "many colors" and then
use only the consonants "mnYc0lOrz."

An acronym for your favorite saying, for example, "Llisn!" (Live! It's Saturday
Night!)

Don't choose:

*

X % ok %k %k

*

*

Your name in any form - first, middle, last, maiden, spelled backwards, nickname
or initials.

Your userid or your userid spelled backwards.

Part of your userid or name.

Any common name, such as Joe.

The name of a close relative, friend, or pet.

Your phone or office number, address, birthday, or anniversary.

Your license-plate number, your social-security number, or any all numeral
password.

Names from popular culture, e.g., spock, sleepy.

Any word in a dictionary.

Passwords of fewer than four characters.

Mum's the Word

Never tell anyone your password -- not even your system administrator or account manager -- and don't
write it down. Make sure you have chosen a password that you can remember. And, finally, change
your password at regular intervals

Reprinted from i/s, Vol. 4, No. 9,
May 1989. Revised March 1993.
Copyright C 1993 MIT Information Systems

Before You Begin...
Remember that passwords are case-sensitive, and note whether your keyboard has Caps Lock on.

How To Use Change Password...
Type your username in the first field of the dialogue box.

Type your current password in the Current Password field.

Type your new password in the New Password field.

Retype your new password in the New Password (again) field to verify it

Press Enter or click OK.

The program checks the username and password you entered and notifies you if either is invalid.
If you have entered the new password twice with consistent spellings, Network Identity Manager
replaces your old password with the new, if it is a strong password. If Kerberos determines the

agrwbdE
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password is weak, a message notifies you, and you need to repeat steps 1 through 4 with a strong
password, as described by the "How To Choose a Password" guidelines above.

How Change Password Works...
When you type into the password fields of the dialog box characters are replaced with bullets. The program
accepts only printable characters for new passwords, i.e., characters between ASCII codes 0x20 and OX7E.

When you have entered the new password twice consistently, the program attempts to change the password
via a dialogue with the Kerberos administrative server. Some Kerberos sites, including MIT's Athena
environment, check the password's strength before allowing the change to take place and notifies you if it
determines that the password is weak.

View:

File Credential WView Options Help

W Advanced F7

Layout b
W All identities
View columns k

Refresh view F5

Advanced Command, F7

Use this command to toggle between the Basic and Advanced view modes for the Network Identity
Manager Application Window.

Layout
File Credential WView Options Help

W Advanced F7

Layout 3 By identity

All identities By type

View columns 4 By location
v Custom

@ Refresh view F5

Page 18



Network ldentity Manager 1.3.1 User Documentation

Kerberos for Windows Release 3.2.2

Layout By Identity
Layout By Identity is the default layout.

A} Network Identity Manager

File Credential View Options Help

OR-ha a8 o

T szentity | Tpe | Loction |

Sendce Name

Time Remaining

O & [3] pHman@ATHENA MITEDU {Default)

B Kerberss 15 credentizls

B ArLjzkmansAT

MNAMIT.EDY

o
o

W
'

"
'3

R [ (3%
o [e o

ol
ch3

o
et

o
et

W
'3

o
'
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"

£

e IR
= KICA cartikicgtes

(]

haouts 33 min...

%]

O houts 33 mih...

9]

O hours 33

[¥]

hours 18 minutes

w1

0 hours 33 min...

ka

O hours 33 min...

k2

ka
[»]

hours 33

Q

s 33 min...

(]

urs 33

(]

houts 33 mih...

9]

ours 33

houts 33 mih...

B winsz "My system store

CMU CA system igen

B & [M izkrman®sECURE-EN

B Kerberss s ckad

jaltman@SECUS

e T CEED AT e i E e
CMESECUVRE-ENDPOINTE.COM

A

AT R T TR D AT e
mESECVRE-ENDPOINTECOM

14 minutes
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14+ mibutes

14 minutes
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fexEstanrord edu

Q|| E@|®
| EENE

tequi 3@ ANDREW.CML EDL
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Layout By Type
Layout By Type provides an alternative view of your credentials ordered by the type of credential instead

of the Identity name.

A Network Identity Manager g@

File Credential View Options Help

DH-BA- =z& O
7| Type | e |
B Kerberos v5 credentials

B & [ phman@ATHENA MITEDU (Defzult)

krbtgt ATHENA

Serdce Name Timea Remaining

20 houts 32 mihutes
-~

e = 1 e
ars/ [3si3te g 7 = ouls 32 mihutes

O hours 32 minutes
2 hours 18 minutes
2 minutes

20 hours 32 minutes

) houts 32 minutes

rs 32 minutes

H @ [ ghmana@ser

| krbtgt/s

13 minutes
. 13 minutes
B AFS credentizls

B & [ skman@SECURE-ENDPOINTS COM

1 & sacy re—er!.':]ps-i nts.com

13 minutes
R cr
B RA certificates

B @& [ phman@ATHENA MITEDY (Defzult)

At A Py e Al = 2
1 MU CA 5y'seem Iqentity | 20 hours 32 minutbes
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Layout By Location
The By Location Layout provides an alternate view of your credentials based not upon the Identity name
but instead on their storage location.

A Network Identity Manager E]@

File Credential View Options Help

OR-OfH- & O
TF|  toation | dentity | Type | Sepvice Mame |
Bl AFS Gache Manager
B @& [A] pkman@SECURE-ENDPOINTS.COM

B AFS credantizls

Time Remaining

- o .
1 as@s&:ul&—ehqpslhts.:snﬂ 13 mlhutes
B Arifakman@ATHENAMIT.EDV

B & [A] hkman@ATHENAMIT.

O Kerberzz o5 credentials

(Defzult)

=
5
Nl
L¥ )
[+

Es

B B EF

-

BF BY OF B3 oY B

Es

]
i
u

B win3z "My systern stohe
B @ [l ikman@aTHENAMITEDY (Defzult)

B KCA certificates

1 CMU CA system igentity 1 20 hours 32 minutes ’

Custom
Custom views can be obtained by clicking on the column headers to produce an ordering of your choice.

All identities

The All identities menu item toggles “view all identities” mode on and off. When on, all configured
identities are displayed in the application window and on the notification icon Set default menu regardless
of whether or not the identities have credentials or are pinned. When off, only the default identity,
identities with credentials and pinned identities will be displayed.
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View Columns
File Credential WView Options Help

W Advanced F7

Layout k

All identities

View columns k| w Service Mame

_ w Identity
M Refresh view F5

- v Type
Issued on
Expires an

Renewable time expires
v Time Remaining
v Renewable Time left
Location
Lifetime
Renewable lifetime
Session EncType
Service EncType
Addresses
v Kerberos w5 Flags
Kvna
Cell
Realm
Method
Client Principal
Server Principal
Realm
Subject (email)
Subject
Issuer

By default only the Service Name, Identity, Credential Type, Time Remaining and Location are displayed.
Using the View->View Columns menu you can select a variety of other credential properties to display in
the NetldMgr window. After displaying the columns, you can re-organize them by dragging the column
headers into the desired location. The selected configuration will be preserved.

Refresh Command, F5

Use this command (in the View menu and the toolbar E‘—?l) to update the display of your current
Credentials.

Why Use It...
Although most end users will likely find this feature irrelevant, application developers and support staff

may occasionally find it to be useful. For example, you may want an immediate status check of available
credentials if you have just used command-line Kinit or kdestroy and want to check that they have
functioned successfully.

How It Works...

While NetldMgr automatically checks the status of your credentials every minute, the Update Display
command forces an immediate status check.
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Options:

File Credential View Options Help
General
Appearance
Identities
Motifications
Plug-ins

kKerberos v4 ..,
AFS ...
Kerberos v5 ...

General Options
The General options dialog, accessed via the Options menu, allows you to configure operational properties
specific to the NetldMgr application.

Network Identity Manager Configuration
General options
=@ Metwork Identity e[|
- General ] Startup [ Shutdown
[ Appearance [+ Obtain new credentials at startup (if none are present)
-'m Identities

[ expired@SE | Destroy all credentials on exit

[ jsltman/root Oth

o jsltman@aT =

[ jaltman@CC I+ Run Network Identity Manager in system tray after window dose

[ jsltman@DE

o jaltmang@rEl_| Clicking on the notification icon |Shnw Metwork Identity rﬂanagj
jaltrman@FEel

g ;altman@FN [+ Monitor network connectivity

[ Jaltman@GR [+ Log trace events to trace log at the following location:

o jsltman@In

O jEltman@rl | C:\DOCUME ~1YjaltmanLOCALS ~1 Temp\nidmdbg. | Show log

[ jsltman@PIL

O Jman @S )

Ok | Cancel | |

The Obtain new credentials at startup (if none are present) checkbox will determine whether or not
NetldMgr will display the New Credentials dialog at startup when no valid credentials exist.

The Destroy all credentials on exit option can be used to empty all of the credential caches when the
NetldMgr is terminated.
The Run NetldMgr in taskbar notification area after window close checkbox determines the behavior

of the window close button. When checked, NetldMgr will close the window but will continue
running and can be accessed from the taskbar notification area. When unchecked, NetldMgr will behave as
if File->Exit was selected from the menu.

Clicking on the notification icon can be configured to either Show Network Identity Manager or Obtain
New Credentials. This option controls which menu item on the notification icon menu is the default action.

The Monitor network connectivity option determines whether or not NetldMgr monitors the
configuration of IP addresses on the machine. When IP addresses are added or removed and this feature is
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activated, the NetldMgr will probe the identity management servers (e.g., Kerberos Key Distribution
Centers) to determine if they are reachable and if so will automatically obtain credentials.

The Log trace events to trace log at the following location option is used to activate a log file that can be

used to help debug the behavior of NetldMgr and its plug-ins. Press the Show log button to view the log
file in Windows Notepad.

Appearance Options

The Appearance Options page can be used to select an alternate typeface to be used when displaying
credentials in the NetldMgr.

Network Identity Manager Configuration

Font for credentials display

Appearance
O General
[] Appearance Font name |Tempus Sans ITC ﬂ
expired @SE
jaltman,root| =
Jaltman@ce Sample test (hormal). OT2T4557830
jaltman@DE
jaltman@FEl
jaltman@F
jaltman@Irl
jaltman@rPIL
v
O PR, o oY

=@ Metwork Identity e[|
-'m Identities
Size |z - [ Bold [ Italics

jaltman@aT,
jalman@rel Sample text (selected). 01234567890
jaltman @GR
;altrnan@IN' Revert to default
jaltman@sEr

( 111 _}_

DD DD D DODODODOOEOO

Ok | Cancel

Identities Options

Identity Options fall into two broad categories: global settings used as default values for Identities and
Identity specific values that override the defaults.
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Global Identity Settings

Network Identity Manager Configuration

Global Identity settings

=g Metwork Identity Mz |
o General [l General lKerberns v5 | Kerberos v4] AFS ]KCA ]

[ Appearance
=] Identities [ Monitor credential expiration

expired @SE [¥ Automatically renew
jaltman,root
jaltman@AT,
jaltman@CC
jaltman@DE
jaltman@FeEl_
jaltman@FEl
jaltman@rFM
jaltman @GR
jaltman@In
jaltman@JrL
jaltman@PIL
Jth‘nan@SEl'v'

[~ Always show in the credentials list (Pinned)

Add new identity. .. |

I DDNDODDDDDODODOo@EoO

O PR Y

EAm &

Ok | Cancel

There are three general settings that can be used to set global defaults.

The Monitor credential expiration setting determines whether or not NetldMgr should monitor the
credential lifetimes and issue expiration notifications. This value is used as the default for all new

identities.

The Automatically renew setting determines if renewable credentials are automatically renewed prior to

expiration. This value is used as the default for all new identities.

The Always show in the credentials list (Pinned) setting determines whether new identities are always
pinned within the credentials list. A pinned identity will always be displayed regardless of whether or not

there are credentials associated with it.
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Network Identity Manager Configuration
Global Identity settings
=@ Metwork Identity ME.A:
m General General Kerberos v5 ]Kerberns v4] AFS ] KCA ]
[0 Appearance
-l Identities Ticket lifetime ||1 day 12 hours
[ expired@SE
[ jaltmanfroot Ticket renewable lifetime |13 days
O jsltman@AT
O jEltman@cc [¥ Renewable [~ Forwardable
[ jsltman@DE 7 | Address]
o jaltmangral ressiess
[ jaltman@Fel Credential lifetime range
O jatman@rn F 1 minute Ti 1day
[ jsltman@cr rom | o |
o jsltman@In . y o
o jaltmangpt Credential renewable lifetime range
[ jaltman@PIL From | 1 minute To | 30 days
o Hmengsery
Ok | Cancel |

The global Kerberos v5 settings define default credential lifetimes and minimum and maximum values for
use in constructing the slider controls used to set the lifetimes.

There are two expiration times associated with Kerberos tickets. The first specifies the length of the time
period during which the tickets are valid for use. The second specifies the length of the renewable lifetime.
Valid Kerberos tickets may have their valid use lifetime repeatedly extended up until the renewable lifetime
expires. The settings on this page are used to configure default lifetime values for NetldMgr to use when
requesting Kerberos tickets from the Kerberos server (key distribution center). The Kerberos server may
issue tickets with shorter lifetimes than were requested.

The Renewable, Forwardable, and Addressless options determine whether or not new identities default to
obtaining Kerberos v5 tickets with these options.

When Forwardable tickets are received from the Kerberos Server, these tickets can be forwarded to a
remote host when you connect via telnet, ssh, ftp, rlogin, or similar applications. When tickets are
forwarded, there is no need to obtain Kerberos tickets again to access Kerberized services on the remote
host. Forwardable tickets are often required when authenticating to a remote host using ssh or ftp when
the remote host requires the ability to authenticate to a remote file system such as AFS.

When Renewable tickets are received from the Kerberos Server, the ticket lifetimes may be renewed
without prompting the user for her password. This allows Kerberos tickets to be issued with short lifetimes
allowing compromised accounts to be disabled on short notice without requiring the user to enter a
password every few hours. When combined with Automatic Ticket Renewal, NetldMgr can maintain
valid tickets for a week, a month, or longer by automatically renewing tickets prior to their expiration. The
ability to renew tickets without a password is limited by the ticket’s renewable lifetime as issued by the
Kerberos Server.

When Addressless is selected, the tickets do not contain IP address information. This enables the tickets to
be used from behind Network Address Translators which are frequently found in Cable and DSL Modems.

The minimum and maximum ranges are used by the ticket initialization dialog box when constructing the

Lifetime and Renewable Lifetime sliders. These sliders can be used to modify the requested ticket
lifetimes when Kerberos tickets are initialized.
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Network Identity Manager Configuration

=@ Metwork Identity Mz
o General
[0 Appearance
-'m Identities
[ expired@SE
[ jsltman/root
O jsltman@AT
o jsltman@CC
[ jsltman@DE
o jsltman@FEl
o jsltman@FEl
O jsltman@FM
o jsltman@GR
o jsltman@In
o jsltman@IPlL
[ jsltman@PIL
o jsltman@sE
|

FRR PR,

(2

Global Identity settings

S

™

General | Kerberosvs Kerberosv4 |ars | kca |

| Obtain Kerberos v4 credentials

Mote that, if enabled, Kerberos v4 credentials will be acquired during
initial credential acquisition and during credential renewals.

However, currently Kerberos w4 credentials can only be obtained for
the default identity.

Ok | Cancel

When the Obtain Kerberos v4 credentials button is checked, NetldMgr will attempt to retrieve Kerberos
v4 credentials when ticket initialization, renewal, or importation is performed. Kerberos realms are
increasingly configured to support only Kerberos v5 (e.g., Windows Active Directory Domains.) If the
realms you use do not support Kerberos v4 it is suggested that this button be unchecked.

Be aware that only the default identity can obtain Kerberos v4 credentials. This limitation is due to the
inability of Kerberos v4 applications on Microsoft Windows to specify a credentials cache.

Network |dentity Manager Configuration

=l Metwork Identity Mz

o General

[ Appearance

-l Identities
[ expired@SE
jaltmanjroot
jaltman@aAT
jaltman@CC
jaltman@DE

Global Identity settings

A

O

O

O

O

[ jaltman@Fel
[ jaltman@Fel
O jaltman@FN
O jaltman@GR.
O jaltman@In
O jaltman@apl
[ jaltman@PIL
O
|

O PR——_Y Y

(i)

jth‘nan@SEl[vl

Generall Kerberos v5 | Kerberos v4  AFS ]KCA ]

[¥ Obtain AFS credentials for new identities

Ok | Cancel

When the Obtain AFS tokens button is checked, NetldMgr will attempt to retrieve AFS tokens when
ticket initialization, renewal, or importation is performed. If you do not frequently access AFS cells, it is
suggested that this button be unchecked.
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Network Identity Manager Configuration

Global Identity settings

=@ Metwork Identity Manac

General General] Kerberos v5 | Kerberos v4 | AFS ~ KCA ]
Appearance

Identities [+ Obtain a KCA certificate
Motifications

Plugins

Kerberos w5

[ Realms

[ Credential Cach

Kerberos w4

AFS

i o I Iy |

[m ]

< | I | [l

Ok | Cancel

When the Obtain a KCA certificate button is checked, NetldMgr will attempt to obtain a KCA certificate
when ticket initialization, renewal, or importation is performed. Most Kerberos realms do not support
KCA certificates, it is suggested that this button be unchecked.
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Identity Specific Options

Each Identity knows to the Network Identity Manager is provided its own set of tabbed pages that can be
used to override the default values specified on the Global Identity Settings pages. There are two
distinctions.

Network |dentity Manager Configuration

Options for jaltman@SECURE-ENDPOINTS.COM

jaltman@In |

jaltman@pl General | kerberos v | Kerberosv4 | aFs | kca |
jaltman@PIL

jaltman@se [+ Monitor credential expiration

jaltman@TR [¥ Automatically renew
jaltman@wi
jea@stanfor
jea@WIN.5
needchange
tequila @AM
Motifications
Plugins
Kerberos w5

[ Realms

[ Credential C —
O Kerberos w4 Remove identity ...

[ AFS
£ m | (&

[¥ Always show in the credentials list (Pinned)

o o o o o o o |

|

Ok | Cancel | |

The General page contains a Remove ldentity button that can be used to delete this Identity from the
Network ldentity Manager.

Network |dentity Manager Configuration

Options for jaltman@SECURE-ENDPOINTS.COM

jaltman@In |

jaltmangpl General KerberosvS |kerberosv4 | aFs | kca |
jaltman@PIL
jaltman@sE! Credential lifetime | 1day
jaltman@TR

jaltman@wi

jea@stanfor v Renewable for | 7 days
jea@WIN.5

needchange [v Can be forwarded to other machines
tequila @AM
Motifications v Addressless
Plugins
Kerberos w5

[ Realms

[ Credential C
o Kerberos w4

m AFS

£ m | (&

o o I o o o o |

|

Credential cache | API:jaltman @SECURE-ENDPOINTS,COM

Ok | Cancel Apply

The Kerberos v5 page displays the name of the credential cache currently associated with the Identity.
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Network Identity Manager Configuration

Options for jatman@ATHENA.MIT.EDU

=@ Metwork Identity Mz

m General General] Kerberos v5  Kerberos v4 ]AFS ]KCA ]
[0 Appearance
=@ Identities [ Obtain Kerberos w4 credentials for this identity
[ expired@SE
[ jsltman/root
O jsltman@AT
o jsltman@CC
[ jsltman@DE
o jsltman@FEl
o jsltman@FEl
O jsltman@FM
(]
(]
(]
(]
o
|

jaltman @GR
jaltman@In
jaltman@JrL
jaltman@PIL
jaltrnan@SEl[v]

FRR PR,

(2

Ok | Cancel Apply

The Kerberos v4 page is optional and may not appear on all systems. Only one identity can obtain
Kerberos v4 credentials at a time.

Network Identity Manager Configuration
Options for jaltman@ATHENA.MIT.EDU
=@ Metwork Identity Mz
m General General ] Kerberos v5 ] Kerberos v4 AFS ] KCA ]
[0 Appearance
=l Identities [+ Obtain AFS credentials
[ expired@SE Credential for
[ jaltmanfroot) = Cell |aﬂﬂena.mit.edu j Add/Update
g ;::m:;ggg Realm |(Autnmaﬁc} j
O jaltman@DE Method |(,s_ut.:,maﬁ.::. j Delete
o jsltman@FEl
[ jaltman@Fel Cell |Realm |Meﬂ10d ”~
O jsltman@FM L}andre»\'.cmu.edu {Auto) (Automa,| =
o jsltman@GR \_jaﬂ"lena.mit.edu {Auto) (Automa.
[ Jaltman@In 1 dcs.cmu.edu €5.CMU.EDU (Automa.
o jaltman@Ipl L}demenﬁa.nrg (Auto) (Automa.v]
[ jsltman@PIL ;i- — ST | . [)]
o ja!trnan@SEl[v]
£ m | 2]
Ok | Cancel | Apply |

The AFS page is optional and may not appear on all systems. A single identity may be used to obtain
tokens for multiple AFS cells. The Add/Update and Delete buttons are used to manage the list of AFS
cells. If the Kerberos realm associated with the AFS cell cannot be automatically determined, it may be
entered manually. The method of AFS token acquisition is one of: “Automatic”, “Kerberos v5”, “Kerberos
v5 to v4” or “Kerberos v4”. Kerberos v5 based tokens should be used when possible. If not, the next best
choice is the Kerberos v5 to v4 translation service. As a last resort, a Kerberos v4 ticket request can be
used directly. In most cases, using “Automatic” will just work.
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Network Identity Manager Configuration
Options for jaltman@ATHENA.MIT.EDU
=@ Metwork Identity Mz
m General General ] Kerberos v5 ] Kerberos v4] AFS  KCA ]
[0 Appearance
- Identities [+ Obtain a KCA certificate for this identity
[ expired@SE
0 jaltmanjroat| = KA Hosts
O jsltman@AT "~ Automatically determine KCA hosts for the identity realm
o J.altrnan@CC * Automatically determine KCA hosts for the following realm:
[ jsltman@DE
o jaltman@FEel |ANDRE'»"'.I'.CI'~"IU.EDU
o jsltman@FEl
[ jaltman@rN " Use the following KCA hosts:
o jsltman@GR |
o jsltman@In
o jsltman@IPlL
[ jsltman@PIL
| jaltrnan@SEl[v]
(] 1l |_ T [>]
Ok | Cancel Apply

A Kerberized Certificate Authority certificate is an X.509 certificate that can be used with web browsers to
authenticate the user as the Kerberos identity even though Kerberos authentication is not used
authentication to the web server. The KCA certificate can be obtained from servers in the identity realm or
from servers in an alternate realm. As of the KCA 1.1 plug-in, only one KCA certificate can be obtained
for a given identity. Obtaining KCA certificates is only available on systems with a KCA plug-in installed.
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Notifications Options

Network Identity Manager Configuration

Notifications

=g Metwork Identity Manag
General ¥ Renew automatically at | 15 minutes
Appearance

Identities [¥ Renew at half life intervals when possible
Motifications
Plugins
Kerberos w5
[ Realms W Final warning at | 5 minutes
[ Credential Cach

Kerberos v4

AFS

¥ Initial warning at | 10 minutes

o o o v

[ ]

2 — 3

Ok | Cancel Apply

The Renew automatically at check box determines whether or not renewable tickets will be renewed by
NetldMgr when they reach the specified time remaining.

The Initial warning at check box determines whether or not a warning will be issued when the specified
time remaining is reached.

The Final warning at check box determines whether or not a warning will be issued when the specified
time remaining is reached.

Notifications are performed in two ways. First, icons are displayed next to the affected credentials in the

flags column of the display. Second, a balloon tip is displayed off of the NetldMgr taskbar notification
area icon.
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Plug-ins and Modules

Network |dentity Manager Configuration
Plugins and Modules
=g Metwork Identity Manag
o General Plugins . AFS Credentials Provider
0 Appearance |Krb5Cred e
+- Identities mﬁfsﬂred
o Nnﬁﬁcaﬁons EKrb#Cred Module IDpenAFS
O Plugins & krbsident
- kerberos v5 EKCACFEd Version I 1.5.1700.0
[ Realms
[ Credential Cach Vendor | (C) 2005-2007 Secure Endpaints In
o Kerberos w4 el kb SCred
O AFS
Status IRunning
Enable ... | Disable ... |
Unregister plugin ...
2 m—r— ) Lo |
Ok I Cancel | Apply |

The Plug-ins and Modules page provides status information on the currently loaded plug-ins and modules
include a description of their purpose; whether or not it was loaded properly; which other modules are
required; and what organization developed it.
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Kerberos v5 Configuration
Important Note for Windows Vista Users. The following Kerberos v5 Configuration features are

incompatible with the Windows Vista User Account Control feature:
e Changing the Default Realm
e The entire Kerberos Realm Configuration page
Do not use these features from a Windows account that is a member of the local machine’s Administrators

group.

Network Identity Manager Configuration

Kerberos v5 Configuration
=@ Metwork Identity Manac

O General DefaultRealm | SECURE-ENDPOINTS,COM |
[0 Appearance
+-p Identities Indude all configured realms in New Credentials
0 Motifications realm list
0 Plugins
-I'[] Kerberos w5 Configuration File
W Reaims Location | C:\WINDOWS Vb5, in

[ Credential Cach

o Kerberos w4
O AFS
Microsoft Windows® Options
Hostname | GALATEA
Domain | WINDOWS
Import |Never j
< >

Ok | Cancel | Apply |

The Kerberos v5 Configuration tab allows you to alter the behavior of the Kerberos v5 identity provider.

In the Default Realm field, select a Kerberos realm from the dropdown list.

The Include all configured realms in New Credentials realm list determines whether all of the realms
declared in the Kerberos v5 Configuration file are included in the realms list of the Obtain New
Credentials dialog. If disabled, only the realms previously used to obtain credentials are displayed.

The Configuration File field displays the path to the Kerberos v5 configuration file, krb5.ini.

The field labeled Host Name displays the name of your local machine. The Domain Name field displays
the domain to which your local machine currently belongs.

The Import Tickets listbox allows you to configure how NetldMgr interacts with the Microsoft Kerberos
Authentication Provider. NetldMgr will automatically import Kerberos Tickets from the Microsoft LSA at
startup depending upon the selected option and whether or not the Kerberos Authentication Provider was
used for Windows Logon authorization.

e Never means do not import tickets from the MSLSA;

e Always means do import tickets from the MSLSA,; and

e  Only when the Principal matches means import tickets from the MSLSA only if the MSLSA

Kerberos principal belongs to the Default Realm.

When the Windows Logon identity is imported and is configured as the default identity, the MIT credential
cache will be used in preference to the MSLSA credential cache.
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Network Identity Manager Configuration

Kerberos Realm Configuration
=@ Metwork Identity Manac

o General
[0 Appearance L] <Mew realm,..> |&
+0 Identities (1 ANDREWY . CMU.EC
@ Motifications O anL.cov
0 Plugins 1 ATHEMA.MIT.EDU| —
=0 Kerberos w5 [ cc.coLumpra.EC 1
@ Realms O cs.cmu.EDU
[ Credential Cach ] CSAIL.MIT.EDU
e i (] DEMENTIA.ORG
O AFS

] DUMMY_REALM
(] GRAND,CENTRA..
(] IASTATE.EDU

] INT-AFS. JPL.MA..
[(_] 111}

| [

< | I | [l

O 1. WIN.STANFO. s

>

Kerberos Servers for ATHEMA.MIT.EDU

Server

Admin

Master

1 <Mew server,.,, >
[ kerberos-1.mit...
[ kerberos-2.mit...
[ kerberos-3.mit...
[ kerberos.mit.e...

Domains that map to ATHEMA.MIT.EDL

Diomain

Mo
Mo
Mo
Yes

Mo
Mo
Mo
Yes

L] <MNew domain mapping. .. =

O mit.edu

Cancel

Apply |

The Kerberos Realm Configuration dialog can be used to manage the contents of the [Realms] and
[Domain_Realm] sections of the Kerberos v5 configuration file.

Network Identity Manager Configuration

Kerberos v5 Credential Caches

=@ Metwork Identity Manac
General
Appearance
Identities

[+ Indude Windows LSA cache (MSLSA:)

File-based Credential Caches

Motifications

File based Credential Caches

Plugins

Kerberos w5

[ Realms

[] Credential Cach
Kerberos w4

AFS

i o I Iy |

[m ]

c:\document and settingsjaltman'krb5.cc

Add |

Remave Selected |

< | I | [l

>

Cancel |

Browse ...

Apply |

The Kerberos v5 Credentials Caches page determines the contents of which credential caches types are
displayed within the Network Identity Manager. The Include all API: credential caches check box
determines whether or not CCAPI caches are included. CCAPI caches are the most frequently used with
MIT Kerberos for Windows. The Include Windows LSA cache (MSLSA:) check box determines
whether or not the Windows Logon Session Identity is displayed within NetldMgr.

The Network Identity Manager can also display the contents of FILE: credential caches. Each FILE:
credential cache must be manually added to the list.
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Kerberos v4 Configuration

Network |dentity Manager Configuration

Kerberos v4 Configuration

jaltman@GR [
jaltman@IN Credential cache | APL:krbdcc
jaltman@JPL
jltman@PIL  Config file path | C:\WINDOWSYrb. con
jaltman@sE
jaltman@TR. Realm file path | C:\WINDOWSkrbrealm. con
jaltman@wi
jea@stanfor
jea@WIN.5
needchange
tequila @AM
Motifications =
Plugins
Kerberos w5

[ Realms

[] Credential C
[] Kerberos w4 [vl

are

&l | (2]

o o o o o

|

Ok | Cancel

Here, you can specify the name of the in-memory cache used to store the Kerberos v4 tickets. The format
of the name is “API.” followed by the cache name. Disk caches are not supported by Kerberos for
Windows.

The paths to the Kerberos v4 configuration files: krb.con and krbrealm.con may be viewed from this dialog.
The default is to store the configuration files in the Windows directory.

AFS Configuration

Network Identity Manager Configuration
AFS Configuration
=g Metwork Identity Manag _
o General AFS Service
[ Appearance Service status |Running
+- Identities :
[ Motifications fiapeEsnies
O Plugins
- kerberos v5 Version | ]
o L OpenAFS Project
[ Credential Cach Company | P !
o Kerberos w4
o AFS Startup options
v Prevent AF5Creds.exe from starting sutomatically when you log in
¥ to Windows.
OpenAF5 Control Panel ... |
< i | [l
Ok | Cancel | Apply |

The AFS Configuration page is optional and may not appear on all systems. The AFS page can be used to
stop and start the AFS Client Service, view the AFS version number and distribution source, and access the
AFS Control Panel.
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The Prevent AFSCreds.exe from starting automatically everytime you log in to Windows feature will
disable the use of the AFS Notification Icon application known as afscreds.exe. This feature is required
until such time as the NetldMgr replaces afscreds.exe in the OpenAFS distribution.

Help:
File Credential View Options Help

[MiHelp Contents

Index
Kerberized Certificates
AFS

About Metwork Identity Manager

About Network Identity Manager
When you access this window from the Help menu, you see a Module list, three radio buttons, and a
Properties button. Modules are executables and dll files that NetldMgr may require.

-,

About Network |dentity Manager

r ] MetIDMgr 1.3.1.0

© 2005-2007 Massachusetts Institute of Technology
© 2006-2007 Secure Endpoints Inc.

Offidal build. Please send bug reports to kfw-bugs @MIT.EDL

Loaded maodules

Mame Path ~
AcGenral, DLL C:WINDOWSWAppPatch\AcGenral . DLL =
ACTIVEDS.dI C:WWINDOWS system32VACTIVEDS. dl

adsldpc.dil CHAWINDOW S \eystem32\adsidpe. dil

ADVAPIIZ.dI C:WINDOWS system32\ADVAPI32.dl

afsauthent.dll c:\program filesiopenafsicommoniafsauthent. dl

afscred.dll C:'Program Files\OpenaAFs\Client\Program'afscred. dll
afscred_en_us.dll C:'Program Files\OpenAFS\Client\Programafscred_en_us.c
afsprocrgmt. dil c:\program files\openafsicommontafsprocmagmt. dil
afspthread.dll c:\program files\openafsicommoniafspthread. dll

afsrpc.dil c:\program files‘openafsicommaonafsrpe, dil

apphelp.dl COAWINDOW S \eystem32\apphelp. dil

ATL.DLL CHWWINDOW Shsystem 32WATL.DLL

BhoCitUs.dll C:WINDOWS \system32\BhoCitUs, dil

bﬁievind.dll C:'\Proagram Files{ThinkPadElustooth Snft'a'are'-bﬂ{ei.find[.dII][V]
& 1l >

The About dialog provides access to the Network Identity Manager version number; the applicable
copyright statement; the e-mail address to which bug reports should be sent; and a list of all of the modules
loaded by the application.
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Windows Taskbar Notification Area

While NetldMgr is running the ) icon will be displayed in the taskbar notification area. Clicking on
the icon with the first mouse button will open or close the Network Identity Manager application window
or open the Obtain New Credentials dialog based upon the current configuration. The behavior can be
adjusted from the Options->General page. Clicking with the second mouse button will display a menu of
commands.

A =the default identity’s credentials are valid

»  =the default identity’s credentials are about to expire

A =the default identity’s credentials are expired

Hovering the mouse over the NetldMgr notification icon will display the name of the default identity.

Windows Taskbar Notification Icon Menu
Show Network Identity Manager window

|~ Obtain new credentials ... Ctrl+M
Renew r

™ Import Credentials Ctrl4I
Destroy 3
Set default r

| % Change password

[MHelp Contents
About Metwork Identity Manager

Exit Cirl+X

The Network Identity Manager notification icon menu provides a shortcut to the most useful NetldMgr
commands. The default action (left button click) is displayed in Bold text. It can be configured from the
Network Identity Manager General Options page. The choices are “Show/Hide Network Identity Manager
window” or “Obtain new credentials ...”.

Show Network Identity Manager window / Hide Network Identity Manager window
The Show Network Identity Manager window item will restore the Network Identity Manager application

window. If the window is already open this option will appear as “Hide Network Identity Manager
window” and will close the application window.

Obtain new credentials ...

The Obtain new credentials item will display the “Obtain new credentials” dialog. See the Network
Identity Manager Commands: Credentials section of this document for more information.
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Renew
Show Network Identity Manager window

[ Obtain new credentials ... Cri+N
Rensw ¥ Rensw all identities

M Im | |

™ Import Credentials Ctrl+l Renew jaltman @ATHENA,MIT.EDU
Destroy ¥

Renew jaltman®CC.COLUMBIA.EDU
Set default 3 Renew jaltman@FMAL. GOV
Rensw jaltman @WINDOWS. SECURE-ENDPOINTS.COM
% Change password
M Help Contents
About Network Identity Manager

Exit Ctrl+X

The Renew item displays a sub-menu that provides a choice of renewing the credentials for all identities or
a specific identity. See the Network Identity Manager Commands: Credentials section of this
document for more information.

Import Credentials

The Import Credentials item will cause NetldMgr to import credentials from available external sources
such as the Microsoft LSA credential cache used to store Windows Domain credentials. See the Network
Identity Manager Commands: Credentials section of this document for more information.

Destrog
Show Network Identity Manager window

|~ Obtain new credentials ... Cirl+M
Renew L
lepu:urt Credentials Ctrl+1

Destroy 3 Destroy all identities

Set default b Destroy jaltman @ATHEMA,MIT.EDU

Destroy jaltman@CC.COLUMELA.EDU

Destroy jaltman@FMAL, GOV

[MHelp Contents Destroy jaltman @WINDOWS . SECURE-ENDPOINTS, COM
About Metwork Identity Manager

| Change password

Exit Ctrl+X

The Destroy item displays a sub-menu that provides a choice of destroying the credentials for all identities
or a specific identity. See the Network Identity Manager Commands: Credentials section of this
document for more information.
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Set Default
Show Network Identity Manager window

|~ Obtain new credentials ... Cirl+M
Renew b
™ Import Credentials Cirl+
Destroy »
Set default ¥| o jaltman@ATHENA.MIT.EDU

jaltman@CC. COLUMBIA.EDU
jaltman@FMAL, GOV
(®Help Contents jaltman @IPL.NASA. GOV

About Metwark Identity Manager jaltman @SECURE-ENDPOINTS.COM

Exit Ctrl+X jaltman@WINDOWS . SECURE-ENDPOINTS. COM
jea@stanford.edu

The Set default menu option displays a list of network identities from which one can be selected as the
default identity. The list contents are determined based upon the setting of the View->All identities menu
option on the NetldMgr application window menu. When View->All identities is unchecked, the list will
contain the current default identity, all identities with credentials, and all identities that are pinned.

| % Change password

The background color of the identity indicates whether or not there are valid credentials.
Green — valid credentials
Yellow — valid credentials nearing expiration
Orange — valid credentials even closer to expiration
Red — expired credentials
White — no credentials
Grey — selection cursor

Change Password
The Change Password item displays the Change Password dialog. See the Network Identity Manager

Commands: Credentials section of this document for more information.

Help Contents
Displays the Network Identity Manager Help File.

About Network Identity Manager
Displays the Network Identity Manager About dialog.

m
=.

Xi
You can use this command to exit the Network Identity Manager.

Important Note...
Exiting NetldMgr will not destroy your current Kerberos tickets unless the Destroy all credentials on exit

option is configured. See the Options->General page.
Toolbar
OR-HA- e @

The Network Identity Manager Toolbar contains buttons which act as shortcuts to the most frequently used
Actions found on the Menubar. From left to right:
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Get Tickets
Renew Tickets
Import Tickets
Destroy Tickets
Change Password
Update Display
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Copyrights

Network Identity Manager Copyright

This software is being provided to you, the LICENSEE, by the Massachusetts Institute of Technology
(M.LT) under the following license. By obtaining, using and/or copying this software, you agree that you
have read, understood, and will comply with these terms and conditions:

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee or royalty is hereby granted, provided that you agree to comply with the following copyright
notice and statements, including the disclaimer, and that the same appear on ALL copies of the software
and documentation, including modifications that you make for internal use or for distribution:

Copyright 1992-2006 by the Massachusetts Institute of Technology. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS 1S", AND M.1.T. MAKES NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED. By way of example, but not limitation, M.1.T. MAKES NO
REPRESENTATIONS OR WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE OR THAT THE USE OF THE LICENSED SOFTWARE OR
DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS,
TRADEMARKS OR OTHER RIGHTS.

The name of the Massachusetts Institute of Technology or M.1.T. may NOT be used in advertising or
publicity pertaining to distribution of the software. Title to copyright in this software and any associated
documentation shall at all times remain with M.1.T., and USER agrees to preserve same.

Project Athena, Athena, Athena MUSE, Discuss, Hesiod, Kerberos, Moira, OLC, X Window System, and
Zephyr are trademarks of the Massachusetts Institute of Technology (MIT). No commercial use of these
trademarks may be made without prior written permission of MIT.

Copyright 2006-2007 by Secure Endpoints Inc. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS IS", AND SECURE ENDPOINTS INC. MAKES NO
REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. By way of example, but not
limitation, SECURE ENDPOINTS INC. MAKES NO REPRESENTATIONS OR WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF
THE LICENSED SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY
PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

Kerberos Copyright

This software is being provided to you, the LICENSEE, by the Massachusetts Institute of Technology
(M.LT.) under the following license. By obtaining, using and/or copying this software, you agree that you
have read, understood, and will comply with these terms and conditions:

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee or royalty is hereby granted, provided that you agree to comply with the following copyright
notice and statements, including the disclaimer, and that the same appear on ALL copies of the software
and documentation, including modifications that you make for internal use or for distribution:

Copyright 1992-2007 by the Massachusetts Institute of Technology. All rights reserved.
THIS SOFTWARE IS PROVIDED "AS IS", AND M.1.T. MAKES NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED. By way of example, but not limitation, M.1.T. MAKES NO

REPRESENTATIONS OR WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE OR THAT THE USE OF THE LICENSED SOFTWARE OR
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DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS,
TRADEMARKS OR OTHER RIGHTS.

The name of the Massachusetts Institute of Technology or M.1.T. may NOT be used in advertising or
publicity pertaining to distribution of the software. Title to copyright in this software and any associated
documentation shall at all times remain with M.1.T., and USER agrees to preserve same.

Project Athena, Athena, Athena MUSE, Discuss, Hesiod, Kerberos, Moira, OLC, X Window System, and
Zephyr are trademarks of the Massachusetts Institute of Technology (MIT). No commercial use of these
trademarks may be made without prior written permission of MIT.

Copyright 2006-2007 by Secure Endpoints Inc. All rights reserved.

THIS SOFTWARE IS PROVIDED "AS IS", AND SECURE ENDPOINTS INC. MAKES NO
REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. By way of example, but not
limitation, SECURE ENDPOINTS INC. MAKES NO REPRESENTATIONS OR WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF
THE LICENSED SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY
PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

Kerberos Export Restrictions and Source Code Access
Copyright (C) 1989-2007 by the Massachusetts Institute of Technology

Export of this software from the United States of America may require a specific license from the
United States Government. It is the responsibility of any person or organization contemplating
export to obtain such a license before exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted, provided that the above copyright notice
appear in all copies and that both that copyright notice and this permission notice appear in supporting
documentation, and that the name of M.I.T. not be used in advertising or publicity pertaining to distribution
of the software without specific, written prior permission. M.1.T. makes no representations about the
suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Export of the documentation is not restricted.

Reporting Bugs and Requesting Assistance

If you find bugs, please mail them to kfw-bugs@MIT.EDU.

kerberos@MIT.EDU is a mailing list set up for discussing Kerberos issues. It is gatewayed to the Usenet
newsgroup ‘comp.protocols.kerberos'. If you prefer to read it via mail, send a request to kerberos-
request@MIT.EDU to get added or subscribe via the web page:

http://mailman.mit.edu/mailman/listinfo/kerberos

Obtaining Kerberos for Windows Source Code and SDK

To retrieve the source code distribution or software development kit for Kerberos for Windows follow the
link to Download: Souces and binaries from MIT via authorization form from the web page
http://web.mit.edu/kerberos/.
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Important notice regarding Kerberos v4 support

In the past few years, several developments have shown the inadequacy of the security of version 4 of the
Kerberos protocol. These developments have led the MIT Kerberos Team to begin the process of ending
support for version 4 of the Kerberos protocol. The plan involves the eventual removal of Kerberos v4
support from the MIT implementation of Kerberos.

The Data Encryption Standard (DES) has reached the end of its useful life. DES is the only encryption
algorithm supported by Kerberos v4, and the increasingly obvious inadequacy of DES motivates the
retirement of the Kerberos v4 protocol. The National Institute of Standards and Technology (NIST), which
had previously certified DES as a US government encryption standard, has officially announced[1] the
withdrawal of the Federal Information Processing Standards (FIPS) for DES.

NIST's action reflects the long-held opinion of the cryptographic community that DES has too small a key
space to be secure. Breaking DES encryption by an exhaustive search of its key space is within the means
of some individuals, many companies, and all major governments. Consequently, DES cannot be
considered secure for any long-term keys, particularly the ticket-granting key that is central to Kerberos.

Serious protocol flaws[2] have been found in Kerberos v4. These flaws permit attacks which require far
less effort than an exhaustive search of the DES key space. These flaws make Kerberos v4 cross-realm
authentication an unacceptable security risk and raise serious questions about the security of the entire
Kerberos v4 protocol.

The known insecurity of DES, combined with the recently discovered protocol flaws, make it extremely
inadvisable to rely on the security of version 4 of the Kerberos protocol. These factors motivate the MIT
Kerberos Team to remove support for Kerberos version 4 from the MIT implementation of Kerberos.

The process of ending Kerberos v4 support began with release 1.3 of MIT Kerberos v5. In release 1.3, the
default run-time configuration of the KDC disables support for version 4 of the Kerberos protocol. Release
1.4 of MIT Kerberos continues to include Kerberos v4 support (also disabled in the KDC with the default
run-time configuration), but we intend to completely remove Kerberos v4 support from some future release
of MIT Kerberos, possibly as early as the 1.5 release of MIT Kerberos.

The MIT Kerberos Team has ended active development of Kerberos v4, except for the eventual removal of
all Kerberos v4 functionality. We will continue to provide critical security fixes for Kerberos v4, but
routine bug fixes and feature enhancements are at an end. We recommend that any sites which have not
already done so begin a migration to Kerberos v5. Kerberos v5 provides significant advantages over
Kerberos v4, including support for strong encryption, extensibility, improved cross-vendor interoperability,
and ongoing development and enhancement.

If you have questions or issues regarding migration to Kerberos v5, we recommend discussing them on the
kerberos@mit.edu mailing list.
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